CLAW1001
Introduction to legal research

Presented by
Emma Petherbridge
Academic Liaison Librarian - Business Law
April 2019
You will learn how to:

– Develop a research strategy for your assignment.

– Use Lexis Advance to find cases and commentary on a particular legal issue.

Legal research trivia
Introduction to legal research - table of contents

This page provides an overview of the resources that you can use for your upcoming CLAW1001 assignment.

If you have any questions about finding and referencing information, please contact Emma Petherbridge (Academic Liaison Librarian, Business Law).

Legal research workshops

- Register for a session

Please refer to the pre-reading below before you attend a session.

Pre-reading / background information

Please review the following information before attending a legal research workshop. It should take less than 20 minutes to complete.

- What are primary and secondary sources? (duration = 3 min 30 sec)
- Legal databases - what resources are available?

Useful legal research tools

- Legal encyclopaedias (duration = 2 min 30 sec)
- Legal dictionaries (1 min 30 sec)
- Case citators (2 min)

Legal research quiz - test your knowledge

- Access quiz questions - these questions will be asked at the start of the upcoming legal research workshops. You can find answers to these questions by reviewing the pre-reading above.
Question #1

Legislation and cases are referred to as ___________ sources of law.
Question #1

Legislation and cases are referred to as primary sources of law.
Question #2

Name some examples of secondary sources:

________________  __________________

________________  __________________
Question #2 - Sources of legal information

**Primary sources**
- Laws made by parliament and the courts

**Secondary sources**
- Publications that explain and provide commentary on primary sources of law

**Legislation**
- Acts / Statutes
  Made by Parliament
- Delegated / Subordinate Legislation
  Regulations, rules and by-laws - made by bodies with authority delegated by Parliament

**Case law**
- Also known as common law
- Legal principles arising from the decisions of judges in previous cases
- Cases published in law reports
- Unreported judgments (available via AustLII)

**Secondary sources**
- Textbooks
- Journal articles
- Legal commentary (looseleaf services)
- Legal encyclopaedias
- Legal dictionaries
- News articles / newsletters
- Conference papers
- Law reform publications
Question #3

Why is it useful to start your research with secondary sources?
Question #3

Secondary sources:

– Provide an overview/summary of the law.

– Can help you to identify key cases and legislation on a given subject.
Question #4

Should you refer to secondary sources (e.g. your textbook, a legal encyclopaedia, legal commentary, etc.) in your assignment?
Question #4

Should you refer to secondary sources (e.g. your textbook, a legal encyclopaedia, legal commentary, etc) in your assignment?

No - Your textbook is not the law.

When you’re stating what the law is, you need to refer to relevant primary sources (i.e. cases)
Use secondary sources as your GPS

Secondary sources
- Legal dictionaries
- Textbooks
- Legal commentary

Legal encyclopaedias

Primary sources
Cases and legislation
Question #5

Halsbury’s Laws of Australia and The Laws of Australia are:

a) Legal dictionaries

b) Law textbooks

c) Legal encyclopaedias

d) Case citators
Question #5

Halsbury’s Laws of Australia and The Laws of Australia are:

a) Legal dictionaries

b) Law textbooks

c) Legal encyclopaedias

d) Case citators
Legal encyclopaedias provide...

An overview of the laws in a particular country.

Halsbury’s Laws of Australia

Print version

Online version via Lexis Advance
Question #6

Why can it be useful to use a legal dictionary?
Question #6 - Legal dictionaries

unjust contract

Encyclopaedic Australian Legal Dictionary

unjust contract

Contract

A contract that is harsh, oppressive or unconscionable in the circumstances in which it was made: for example (NSW) Contracts Review Act 1980 s 4(1); Beneficial Finance Corp Ltd v Karavas (1991) 23 NSWLR 256; ASC ¶56-042. In New South Wales, a court may refuse to enforce in whole or in part, rescind in whole or in part, or vary any provision of, an unjust contract: (NSW) Contracts Review Act 1980 s 7. A contract may be unjust because its terms, consequences or effects are unjust ("substantive injustice") or because of the unfairness of the methods used to make it ("procedural injustice"): West v AGC (Advances) Ltd (1986) 5 NSWLR 610; ASC ¶55-500.

See also contract; contract of employment; unconscionable; unfair contract.

Provide the meaning of words and phrases in a legal context

They often refer to cases and legislation that deal with the meaning of the word or phrase

Identify related words/topics
Question #7

What’s the name of the legal research tool that can perform the following functions?

- Find cases on a topic
- See how a particular case has been considered in later judgments
- Check the citation details for a particular case
Question #7

What’s the name of the legal research tool that can perform the following functions?

▪ Find cases on a topic
▪ See how a particular case has been considered in later judgments
▪ Check the citation details for a particular case

Answer: Case citator
CaseBase (case citator)

Ermogenous v Greek Orthodox Community of SA Inc

Copy Citation  Hide Signals


Citation details - where the case has been published

Check how the case has been considered in later judgments

View a brief summary of the case

In this document:
Catchwords & Digest  Litigation History  Cases referring to this case  Publications referring to this case  Cases considered by this case

Employment — Contract — Minister of religion — Intention to create legal relations

Appeal against decision of Full Court of Supreme Court of South Australia setting aside decision of Industrial Relations Court of South Australia to award annual leave and long service leave entitlements.

Initial application by appellant to magistrate of Industrial Relations Court alleged sums owed to appellant in form of annual leave and long service leave.
Question #8

Name the 3 major commercial/subscription legal databases in Australia:

_________________  ____________________

_________________
Question #8

Name the 3 major commercial legal databases in Australia:

Lexis Advance

CCH IntelliConnect

Westlaw AU
Question #9

Name the two major free legal websites for finding cases in Australia:

_________________________  ________________________
Question #9

The two major free legal websites for finding cases in Australia are:

www.austlii.edu.au  jade.io
Assignment tips
Review sample problem questions
Problem questions - sample answers

Sample contract law exam Q&A


Note: This example was written as an exam answer, so it doesn't include the AGLC referencing style that is required for your assignment.

Problem questions - Contract law

Produced by the Sydney Law School. View a sample answer that would receive a pass, credit, distinction, or high distinction.

Note: If the above link doesn't work for you, click here to access an archived copy.

Access via the Library resources section in your CLAW1001 Canvas site.
Chapter 3 – Content of Contracts

Question 17

Walter is a technology expert who also enjoys working with his hands. For his niece Lilly’s birthday, he built a doll into which he inserted a motherboard that enabled the doll to be programmed to sing songs using her name. The doll was a big hit with Lilly. Bianca, Lilly’s mother and Walter’s sister, suggested that Walter should try to market his invention. She helped him to do the necessary paperwork to register the design and to trademark the name Lullaby Lillies. However, when he tried to sell the doll to several toy makers he only received knockbacks because they could see nothing new in a ‘singing doll’. Walter decided to make the doll himself in his garage, aided by the labours of a group of retired friends.

Walter’s old school friend Anna owned a struggling toy shop in the Megadome shopping plaza. Her lease was soon to expire and she was prepared to walk away from her shop. Walter saw Anna’s shop as being ideally located as an outlet for his new doll. He therefore approached Anna with the following proposition: he would make Anna the exclusive outlet for his Lullaby Lillies if Anna renewed her lease with Megadome for a further five years. On the strength of this statement, Anna renewed her shop lease for five years.

Walter’s Lullaby Lillies quickly gained a reputation and became much in demand, so much so that his small garage operation struggled to keep up with orders. He had approaches from several major department store chains with shops all over the country wanting to sell Lullaby Lillies. In particular, one generous offer involved taking over the manufacture and marketing of the dolls and included sizeable rewards for the retired friends who had helped him. When he told Anna, she felt threatened, since the Lullaby Lillies had been the highest grossing item she had ever sold. They have a falling out. Walter told Anna:

Answer Plan

(a) Anna v Walter
- Oral statement preceding lease contract
  - promissory or mere inducement?
- If promissory, was it a collateral contract?
  - definition of collateral contract
  - elements of a collateral contract
  - bipartite or tripartite collateral contract
  - remedy for breach of collateral contract

(b) Bianca v Walter
- Agreement
- Intention
- Consideration

Suggested Answer

(a) Anna v Walter

3-21 Anna will wish to enforce the statement made by Walter that he would provide the dolls exclusively to Anna’s store for the next five years. This is an oral statement that preceded the contract entered into between Anna and Megadome for the store lease. It is an objective test of the parties’ intentions whether that statement was promissory or a mere inducement to enter into the contract: Oscar Chess Ltd v Williams [1957] 1 WLR 370. It would seem that the statement by Walter was couched in terms that he would undertake to do something, and seems more likely to be promissory in nature than a statement made merely to induce the lease contract.

The consideration for this promise was Anna’s entry into the lease agreement: Heilbet Symons v Buckleton [1913] AC 30. Three elements must be established for a statement to form the basis of a collateral contract:
Identifying legal issues
Identifying legal issues

Before you can solve a legal problem, you need to:

▪ Have an understanding of the relevant legal area

▪ Know enough to identify a starting point for your research e.g. a legal issue, a relevant case, etc.

(source: Sydney Law Extension Committee).
Do some background reading

Start with your lecture slides and textbook

“You will find that most of the issues in the assignment have already been covered at length in lectures and tutorials. For these issues, it will be sufficient to refer to the cases and legislative materials from the textbook, slides and tutorials. You will also find that there may be some issues that have not been covered in great detail in lectures and tutorials. It is recommended that for these issues, you should do your own research to find relevant cases and materials.”

(Source: CLAW1001 - FAQs).
Background reading is the foundation for your research

Think of your research process as like building a house.
Background reading is the foundation on which the house is built.
Background reading - Australian contract law

**Legal commentary services**
- *Carter on Contract* (via Lexis Advance)
- *Australian Contract Law Commentary* (via CCH)

**Legal encyclopaedias**
Browsing vs. searching

Browsing is useful when you want to:

- See how a subject is organised
- See the connections between topics

Click on the + sign to expand the menu.
Developing your search strategy
Choosing your search terms
Choosing your search terms

❌ Don’t
- Enter every word from your assignment question.

✅ Think of words that:
- Relate to the legal issues you’ve identified.
- Are likely to appear in the text of relevant search results.
Choosing your search terms

Think of related terms / synonyms

- Exclusion clause
- Exception clause
- Exemption clause
- Exempting clause
Choosing your search terms

Consider the different ways that words/concepts may be described and ordered.

“immediately bound” ➔  "bound immediately"

❑  "immediately binding"
❑  "immediately binds"
❑  "immediate and binding effect"
How do you search for different combinations of words?
Search operators
<table>
<thead>
<tr>
<th>Search operators guide</th>
<th>Lexis Advance® Including CaseBase</th>
<th>WestlawAU Including FirstPoint</th>
<th>CCH</th>
<th>AustLII</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exact phrase</strong></td>
<td>“duty of care”</td>
<td>“duty of care”</td>
<td>“duty of care”</td>
<td>“duty of care”</td>
</tr>
<tr>
<td><strong>All words</strong></td>
<td>contract and terms</td>
<td>contract &amp; terms or contract terms [blank space]</td>
<td>contract and terms</td>
<td>contract and terms</td>
</tr>
<tr>
<td><strong>Any words</strong></td>
<td>internet or online</td>
<td>internet or online</td>
<td>internet or online</td>
<td>internet or online</td>
</tr>
<tr>
<td><strong>Exclude a word</strong></td>
<td>loan and not gift</td>
<td>loan % gift</td>
<td>loan not gift</td>
<td>loan not gift</td>
</tr>
<tr>
<td><strong>Find different endings of a word (truncation)</strong></td>
<td>! tax! = tax, taxed, taxation, taxing etc.</td>
<td>! tax! = tax, taxed, taxation, taxing etc.</td>
<td>* tax* = tax, taxed, taxation, taxing etc.</td>
<td>* tax* = tax, taxed, taxation, taxing etc.</td>
</tr>
<tr>
<td><strong>Use brackets to search for any related terms</strong></td>
<td>excise and (wine or beer or spirits)</td>
<td>excise &amp; (wine or beer or spirits)</td>
<td>excise and (wine or beer or spirits)</td>
<td>excise and (wine or beer or spirits)</td>
</tr>
<tr>
<td><strong>Proximity searches</strong></td>
<td>/n [within n words] n can be any number up to 255 consumer /3 protection</td>
<td>/n [within n words] n can be any number consumer /3 protection</td>
<td>/n [within n words] n can be any number consumer /3 protection</td>
<td>near [within 50 words] consumer near protection</td>
</tr>
<tr>
<td></td>
<td>/s [within same sentence] unfair /s contract</td>
<td>unfair +3 contract [1st term must appear up to n words before the 2nd term]</td>
<td>w/sen [within 20 words] unfair w/3 contract</td>
<td>w/par [within 80 words] online w/par contract</td>
</tr>
<tr>
<td></td>
<td>/p [within same paragraph] online /p contract</td>
<td>online w/3 contract</td>
<td>online pre/3 contract</td>
<td>w/par [within 80 words] online w/par contract</td>
</tr>
</tbody>
</table>
Search operators - quotation marks " "

e.g. "intention to create legal relations"

The database will search for the words as an exact phrase.
Search operators - AND

e.g. contract **AND** terminate

The database will only find results that contain both words.

3. BREACH OF CONDITION

Carter on Contract

... Mona Homes Pty Ltd v the vendor to ‘proceed ... condition the breach of which gave them a right to terminate the **contract**. Arguably the words ‘all due dispatch’ were a strong indication ...

... as may be mutually agreed upon’ either party to the **contract** could terminate its performance. This termination clause was said to be a good indication that the ...

... did not intend every delay to be a ground for termination. 1. See Tramways Advertising Pty Ltd v Luna Park ...

... visits by Wickman to Schuler’s clients a ‘condition’ of the **contract**. Schuler argued that as the term was a condition any ...

... breach by Wickman would give rise to a right to terminate the performance of the **contract**. The House of Lords rejected the argument. The use of ...

... when regard was had to the other terms of the **contract**, it was clear that the term in issue was intermediate ...
Search operators - OR

Use **OR** to search for similar words e.g. internet **OR** online

The database will find results that contain either or both words.
internet OR online

Some results mention online

... entry per Lord Pearson. 7. Examples might include **online** defamation, **online** misrepresentation, an action in passing off based on **online** conduct, intellectual property claims in relation to use of material **online**, and trade

Some results mention the internet

... the importance of the **internet** as one of the great innovations of the information age. ... 
... the first place. 20 In terms of the rights of **internet** users, it is argued that the correct approach to infringement ...

Some results mention both words

**Online** Privacy and the **Online** Self (2008) 4(9) PrivLB 116 ; (2008) 10(9) INTLB ...
... Catchwords & Digest Intellectual property **internet Online** privacy Intellectual property enforcement Examination of overlooked methods to gather information from personal **internet** use. Argument to legislatively protect **internet** pseudonymous identities....
Search operators

Use **AND** to narrow your search

Use **OR** to broaden your search
Search operators - NOT

Exclude an irrelevant word from your search results.

e.g. contract **NOT** terminate

The database will find results that contain the word *contract* but not the word *terminate*. 
Search operators - truncation ( * ! )

Search for different endings of a word.

e.g. contract* - the database will find results that contain either contract, contracts, contracted, or contractual.

Truncation symbols vary across databases:

! (exclamation mark) - Lexis Advance and Westlaw AU

* (asterix) - CCH and AustLII
Search operators - ( brackets )

Use brackets ( ) to group related search terms.

e.g.

(shopping OR retail OR buy) **AND** (online OR internet OR web)
# Search operators - proximity connectors

The database will find results where your search terms appear closely together.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/n</td>
<td>[within (n) words] (n) can be any number up to 255 consumer /3 protection consumer /3 protection</td>
<td>consumer /3 protection</td>
</tr>
<tr>
<td>/s</td>
<td>[within same sentence] unfair /s contract unfair +3 contract</td>
<td>unfair +3 contract [1(^n) term must appear up to (n) words before the 2(^{nd}) term]</td>
</tr>
<tr>
<td>/p</td>
<td>[within same paragraph] online /p contract online /p contract</td>
<td>n can be any number</td>
</tr>
<tr>
<td>w/n</td>
<td>[within (n) words] (n) can be any number consumer w/3 protection consumer w/3 protection</td>
<td>consumer w/3 protection</td>
</tr>
<tr>
<td>w/sen</td>
<td>[within 20 words] unfair w/sen contract unfair w/sen contract</td>
<td>unfair w/sen contract</td>
</tr>
<tr>
<td>w/par</td>
<td>[within 80 words] online w/par contract online w/par contract</td>
<td>online w/par contract</td>
</tr>
<tr>
<td>near</td>
<td>[within 50 words] near protection</td>
<td>near protection</td>
</tr>
<tr>
<td>w/n</td>
<td>[within (n) words] unfair w/3 contract unfair w/3 contract</td>
<td>unfair w/3 contract</td>
</tr>
<tr>
<td>pre/n</td>
<td>online pre/3 contract online pre/3 contract [1(^n) term must appear up to (n) words before the 2(^{nd}) term] online pre/3 contract</td>
<td></td>
</tr>
<tr>
<td></td>
<td>n can be any number n can be any number</td>
<td>n can be any number</td>
</tr>
</tbody>
</table>
When are proximity connectors useful?

When you’re searching for a topic that may be described in different ways.

e.g. contract /5 terminate

Contracts may also terminate to terminate contract terminate the contract terminate a contract contracts that terminate
Open your mind to the power of search operators!

typing words into a database

“quotation marks”
AND, OR, NOT

truncation (* or !)

brackets ( )
proximity connectors e.g. /5
Lexis Advance - group activities

- p. 8 - legal dictionary - activity #1
- p. 9 - Halsbury’s Laws of Australia (legal encyclopaedia) - activity #2
- p. 10 - Carter on Contract (find commentary on Australian contract law) - activity #3
- p. 11 - legal commentary - activity #4

Brainstorm a list of potential searches to find commentary on implied terms of good faith

What search operators could be used? e.g. “implied terms” and “good faith”
Referencing

AGLC4
How to access

Google

aglc4

About - Melbourne Law School - University of Melbourne
https://law.unimelb.edu.au > Melbourne University Law Review > AGLC ▼
On this page; About the Australian Guide to Legal Citation ('AGLC'); The Fourth Edition of the Australian Guide to Legal Citation ('AGLC4'); AGLC4 Erratum; The ...
Search within the AGLC

Mac

command
F

PC

Ctrl
F
AGLC is a footnote style

Your references should appear at the bottom of each page.

Some judges have argued that a presumption of advancement applies wherever there is a ‘greater prima facie probability of a beneficial interest being intended’.¹

This situation is likely to occur only in the rarest of cases, since the court can always make a judgement about the relative credibility of evidence given by living parties.²²

¹ Wirth v Wirth (1956) 98 CLR 228, 237 (Dixon CJ). See also Calverley v Green (1984) 155 CLR 242, 250 (Gibbs CJ).

²² In Gissing v Gissing [1971] AC 886, 907, Lord Diplock commented that presumptions are easily rebutted if both parties are still alive and capable of giving evidence.

Source: AGLC, Rule 1.1.1
Why use footnotes?

Rule 1.1.1 of the AGLC states that you should use footnotes to:

– Provide a legal authority for your proposition/argument; and

– Provide sufficient information for the reader to locate your references
How to add a footnote in Microsoft Word

Place your cursor after your full stop / punctuation mark.

Click on the References tab and select Insert Footnote.
DIY activity - create this footnote reference in Word

The consideration for this promise was Anna’s entry into the lease agreement.¹


The details for this example were sourced from:
Formatting tips

Avoid footnotes that look like this…

1 Darlington Futures Ltd v Delco Australia Pty Ltd

CaseBase (1986) 161 CLR 500
Formatting tips

Select **Paste Special > Unformatted Text**
Why are case names followed by different numbers and letters?
Medium neutral citations

Baltic Shipping Co v Dillon [1993] HCA 4

- **An abbreviation for the relevant court or tribunal**: HCA = High Court of Australia
- **The year of the judgment in square brackets**: [1993]
- **A sequential judgment number**: 4 = the 4th judgment from the High Court in 1993

**Sequential judgment number** for the relevant court/tribunal in a calendar year.
Access unreported judgments via AustLII


HIGH COURT OF AUSTRALIA

BALTIC SHIPPING COMPANY v. DILLON [1993] HCA 4; (1993) 176 CLR 344

F.C. 93/001

Number of pages - 29

Contract

HIGH COURT OF AUSTRALIA
Access unreported judgments via Jade
Significant judgments are published in law reports

Only a small % of judgments are ‘reported’.

Court decisions are selected based on their value as precedents.

(Sanderson & Kelly 2014, p. 74).
How to check if a case has been ‘reported’

Use a case citator e.g. CaseBase to check if a case has been published in a law report series.

This judgment has been published in 5 law reports:

Baltic Shipping Co v Dillon (The Ship Mikhail Lermontov)(Ticket case)


Court: HCA
Judges: Mason CJ, Brennan, Deane, Dawson, Toohey, Gaudron, McHugh JJ
Judgment Date: 10/2/1993
Law report - citation details

Baltic Shipping Co v Dillon *(1993) 176 CLR 344*

- **An abbreviation** for the **law report** series
  CLR = Commonwealth Law Reports

- **The year of the judgment**

- **The volume** in which the case is published
  i.e. this case can be found in volume 176 of the report series

- **Page number** - where the case first appears
  i.e. this case can be found on page 344 of volume 176
How to cite a reported case


- The case name in italics
- The year of the judgment
- The volume in which the case is published
  - i.e. this case can be found in volume 176 of the report series
- Page number - where the case first appears
  - i.e. this case can be found on page 344 of volume 176
- An abbreviation for the law report series
  - CLR = Commonwealth Law Reports
- Full stop
How to refer to a specific page within a case

A pinpoint reference refers to a specific page or paragraph within a case (rule 2.2.5).


The surname of the judicial officer whose judgment is being cited

CJ = Chief Justice, J = Justice
Which version of a case should you cite?

Significant judgments may be published in more than one law report series. These are called **parallel citations**.

This judgment has been published in 5 law reports:

Baltic Shipping Co v Dillon (The Ship Mikhail Lermontov)(Ticket case)


**Rule 2.2.7** of AGLC - parallel citations should not be used - the “**most authoritative available version**” should be cited.
Which version of a case should you cite?

Tip - look up the case in CaseBase (LexisNexis AU)

Baltic Shipping Co v Dillon (The Ship Mikhail Lermontov) (Ticket case)

For Australian judgments, CaseBase always lists the most authoritative case citation first.
How to cite an unreported decision

Reliance Financial Services Pty Ltd v Criniti [2018] NSWSC 543.

- **Case name**: Reliance Financial Services Pty Ltd v Criniti
- **Year of the judgment**: [2018]
- **Abbreviation for the relevant court or tribunal**: NSWSC = NSW Supreme Court
- **Judgment number**: 543 = the 543rd judgment from the NSW Supreme Court in 2018

**Full stop**
How to refer to a specific paragraph within a case

A **pinpoint reference** for an unreported judgment = a specific paragraph within the case.

*Reliance Financial Services Pty Ltd v Criniti [2018] NSWSC 543, [22] (Davies J).*

The surname of the judicial officer whose judgment is being cited (J = Justice)
Check your word count

Click on the **Review** tab and select **Word Count**
Reference list
Your reference list is called a bibliography in AGLC4

Refer to Rule 1.13 - Bibliographies

BIBLIOGRAPHY

A Cases

*Baltic Shipping Co v Dillon* (1993) 176 CLR 344
*Masters v Cameron* (1954) 91 CLR 353
*Olley v Marlborough Court Ltd [1949] 1 KB 532

B Legislation

*Competition and Consumer Act 2010* (Cth)
*Sale of Goods Act 1923* (NSW)

Your cases should be in alphabetical order.
What’s wrong with the following footnote?

_Baltic Shipping Company v Dillon_ (1993) 176 CLR 344
What’s wrong with the following footnote?


*Company* should be shortened to *Co* (rule 2.1.2)

A full stop should appear at the end (rule 1.1.4)
What’s wrong with the following footnote?

What’s wrong with the following footnote?

The most authoritative version of a case should be cited (rule 2.2.2)


[https://jade.io/article/67770?at.hl](https://jade.io/article/67770?at.hl)

Don’t include weblinks in your footnotes/reference list. AGLC ≠ APA
HELP!
Can’t find the information you need?

Unsure about how to reference a particular item?
Emma Petherbridge

Academic Liaison Librarian: Accounting, Business Law and International Business

Contact details

Email: emma.petherbridge@sydney.edu.au
Phone: +61 2 8627 4484
Schedule an appointment with Emma Petherbridge

Location

Level 2
F03 - Fisher Library
The University of Sydney
NSW 2006 Australia

Click here to get information on what Academic Liaison Librarians duties are and how they can help you.